**Trademark Information**

Polycom®, the Polycom “Triangles” logo, and the names and marks associated with Polycom’s products are trademarks and/or service marks of Polycom, Inc., and are registered and/or common-law marks in the United States and various other countries.

All other trademarks are the property of their respective owners.

**Patent Information**

The accompanying product may be protected by one or more U.S. and foreign patents and/or pending patent applications held by Polycom, Inc.

**Open Source Software Used in this Product**

Polycom Accordent Capture Station contains—in part—open source software, software licensed in a way that allows you the freedom to run, copy, distribute, change, and improve the software.

You can receive the open source software from Polycom up to three (3) years after the distribution date of the applicable product or software at a charge not greater than the cost to Polycom of shipping or distributing the software to you.

For a list of the available open source software, as well as related license and copyright information, you can contact Polycom at the address listed below, or see "Polycom VCM&D OFFER of Source for GPL and LGPL Software Open Source Code " available at:

http://downloads.polycom.com/network/vcmd/offerForSourceVCMProducts.html

To receive software information, as well as the open source software code used in this product, contact Polycom by regular mail or email at:

Polycom VCM&D Open Source Manager
300 N. Continental Blvd. Suite 200
El Segundo, CA 90245 USA

E-mail: DL-OpenSource Video <OpenSourceVideo@polycom.com>

© 2011 Polycom, Inc. All rights reserved.

Polycom, Inc.
4750 Willow Road
Pleasanton, CA 94588-2708
USA

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without the express written permission of Polycom, Inc. Under the law, reproducing includes translating into another language or format.

As between the parties, Polycom, Inc., retains title to and ownership of all proprietary rights with respect to the software contained within its products. The software is protected by United States copyright laws and international treaty provision. Therefore, you must treat the software like any other copyrighted material (e.g., a book or sound recording).

Every effort has been made to ensure that the information in this manual is accurate. Polycom, Inc., is not responsible for printing or clerical errors. Information in this document is subject to change without notice.
Contents

1 Introduction

2 System Requirements and Installation
   System Requirements ................................................................. 2–1
   Author Requirements ................................................................. 2–1
      Software ............................................................................. 2–1
      Hardware ............................................................................. 2–1
   Audience Requirements ............................................................. 2–1
      Software ............................................................................. 2–1
   Download and Installation ......................................................... 2–2

3 Getting Started
   Launching Polycom RealPresence Media Editor ......................... 3–1
   Selecting the Streaming Media File .......................................... 3–2
      Local Media File .................................................................... 3–3
      Capture Live .......................................................................... 3–3
   Using the Launch Page Drop-Down Menu .................................. 3–5
      File Menu ............................................................................. 3–5
      Edit Menu ............................................................................. 3–6
      Help Menu ............................................................................ 3–7

4 Creating a Presentation
   Creating a Presentation Overview .............................................. 4–1
   Selecting and Customizing an Interface ...................................... 4–1
   Synchronizing Content .............................................................. 4–4
      Importing and Organizing Assets ............................................ 4–5
         Importing Assets ................................................................. 4–5
         Arranging Assets ............................................................... 4–7
         Synchronizing Assets ......................................................... 4–7
         Synchronizing URLs ......................................................... 4–10
         Creating and Synchronizing Bookmarks ......................... 4–12
         Synchronizing Closed Captioning Text .............................. 4–13
   Editing an Asset, URL or Bookmark .......................................... 4–16
      Drag-and-drop editing ............................................................. 4–16
      Using The Right-Click Functions To Edit ............................... 4–17
      Editing Using My Assets ...................................................... 4–19
      Editing Using The Scrollbar ................................................. 4–20
5 Previewing a Presentation

Choosing Preview Modes ........................................ 5-1
Previewing A Presentation ........................................ 5-3

6 Archiving and Publishing a Presentation

Archiving and Publishing Overview ................................. 6-1
Settings Screen Overview .......................................... 6-3
Completing the Web Content Page ................................. 6-4
Completing the Web Content Page ................................. 6-4
Web Server URL Field ........................................... 6-4
Upload Type Field .................................................. 6-5
Completing the Smooth Streaming Media, Windows Media and Flash Media Content Pages .......................... 6-8
Firewall Settings Page .............................................. 6-11
Completing The Publish Screen .................................... 6-13

7 Using Resources and Shortcuts

Drop-Down Menu Overview ......................................... 7-1
File Menu .............................................................. 7-1
Edit Menu .............................................................. 7-2
Assets Menu ........................................................... 7-3
Resources Menu ...................................................... 7-4
Help Menu ............................................................. 7-4
Kontiki Settings ......................................................... 7-5
RealPresence Media Editor Hot Keys .............................. 7-5
Introduction

Polycom RealPresence Media Editor is a software-based authoring tool that enables almost anyone to create professional, multimedia presentations around on-demand streaming media.

The Polycom RealPresence Media Editor workflow comprises five easy steps:

1 Selecting Media: Polycom RealPresence Media Editor supports several different media formats, including Expression Encoder, WindowsMedia, Flash, MP3 and more. Polycom RealPresence Media Editor enables a content author to use audio/video that resides locally or is captured live and published on demand.

2 Selecting an Interface: After a media source or file has been selected, you will use the "Skins" page to select and customize a presentation interface. Polycom RealPresence Media Editor includes several customizable interfaces and, since Polycom interfaces are standards-based, you can easily create your own using virtually any third party graphics program.

3 Synchronizing Assets: Use the "Sync" page to synchronize images, including jpegs, gifs, and PDFs, Flash files, URLs, as well as to create bookmarks that will enable the audience to jump to specific parts of the presentation. Polycom RealPresence Media Editor enables synchronized assets to be targeted to the interface.

4 Previewing and Editing A Presentation: After you have created a synchronized presentation, use the preview features to watch the presentation directly within Polycom RealPresence Media Editor. You can preview a specific synchronization region, multiple synchronization regions, and even undock the preview frames to resize them and move them around your desktop. If you need to make a change, drag the asset tags to different locations on the time bar, delete tags, or add new tags.

5 Publishing a Presentation: After you have finished your presentation, you can publish it locally, to CD, or to a web and streaming server - all automatically.

This User’s Guide explains how Polycom RealPresence Media Editor helps you create, manage and publish superior presentations with unprecedented ease and efficiency.
System Requirements and Installation

System Requirements

Author Requirements

Software
- Windows 2K or higher
- Internet Explorer 7 or higher
- Windows Media Player 9.0 or higher (for Microsoft-encoded content)
- Microsoft PowerPoint (if including PowerPoint slides)
- Macromedia Shockwave Player (if including Flash files)
- Microsoft Expression Encoder Pro SP1 or higher (for Expression-encoded content)

Hardware
- Pentium 4 or comparable CPU
- Monitor: SVGA color monitor. Minimum 1024x768 screen resolution or higher
- 512 MB of RAM or higher
- 40 GB minimum Hard Drive

Audience Requirements

Software
- Internet Explorer 5.5 or higher
Download and Installation

When Polycom RealPresence Media Editor is downloaded it will be delivered as a self-extracting .exe file.

1. Click Setup (setup.exe).

2. When the Welcome screen appears, click Next.

3. On the Destination Location screen, choose one of the following:
   - Select a location for Polycom RealPresence Media Editor using the Browse button.
   - Use the default setting, and then click Next.

4. On the Start Installation screen, click Next. Polycom RealPresence Media Editor will begin installing.

5. When the Successful Installation screen is displayed, click Finish.
Getting Started

Launching Accordent PresenterPLUS

To launch Accordent PresenterPLUS, first click the desktop Start menu. Next, click Programs, Accordent, and then PresenterPLUS.

If Accordent PresenterPLUS is being launched for the first time, the Polycom end user license agreement will appear. Click I Agree.

Immediately after clicking "I Agree," the product activation page will appear (See Figure 3-1).

![Figure 3-1](image)

You must activate the product before using. If you do not have an internet connection on the machine you are installing to, please contact Polycom support to go through the manual license activation process.
After entering the activation key, click “Activate via Internet”. Once activation is complete, the Media Editor main screen will appear

*Figure 3-2*

Selecting the Streaming Media File

The presentation wizard will guide you through the process of creating your presentation.

The first thing you must do is select your streaming media file. Choose one stream at a time. If you are working with more than one stream, or more than one media format, there will be an opportunity to select these other streams after publishing the first one. You will not need to go through the process of re-synchronizing or previewing subsequent streams after successfully publishing the first one.

Polycom RealPresence Media Editor offers two ways to access your streaming media.

**Local Media File**

Use this option when the media file you are using for your presentation is locally stored, either on your hard drive, on disk, or accessible via a network.
After selecting Local Media File, click **Next**.

Locate the streaming media file by clicking on the **Browse** button.

Click **Begin**.

**Capture Live**

Use this option when you are recording your media live into an encoder and would like to embed synchronization on the fly, as the media is recording. After you are finished, you can preview, edit and then publish it for on demand use.
The Accordent PresenterPLUS presentation wizard will launch simultaneously with the encoding device you chose in the previous step.
Immediately after selecting a media format, Media Editor will appear.
Using the Launch Page Drop-Down Menu

The Media Editor launch page contains File, Edit and Help drop-down menus that provide shortcuts to primary Media editor features as well as to several Media Editor resources.

Below is a list of the available Media Editor drop-down menu shortcuts.

File Menu

The File drop-down menu contains several function and feature shortcuts to primary Media Editor features.
**Choose Media Type:** If you have selected a media type (e.g. capture live) and want to change the selection, the Choose Media Type option will bring you back to the screen where you can select a new media type.

**Local Media File:** The Local Media File option will open a Browse Window where you can select a local media file that will be incorporated into the presentation.

**Capture Live:** The Capture Live option will take you directly to the Capture Live screen.

**Load Presentation:** The Load Presentation feature enables you to import a previously created presentation. After imported, you will be able to edit and re-publish the presentation, if desired.

You may also have the last few presentations, which have been loaded, available for quick launching of a presentation.

**Exit:** After providing an opportunity to save the presentation, the Exit feature will close Polycom RealPresence Media Editor.

### Edit Menu

The Edit menu contains the Preferences option.

**Figure 3-11**

![Preferences Window](image)

**Preferences:** The Preferences option is used to specify many specifics of how Media Editor will function during your use from this point on. First you choose your local work folder.

The **Clear** button is used to clear the list of recently opened projects.

Language and Locale settings allow you to choose what language the software interface will appear in, and what formats should be used for dates.
Finally the **Skin Path** is used to tell Media Editor where you are accessing your interfaces from. This can either be a local path or a network storage location.

### Help Menu

The Help menu contains several shortcuts to Media Editor support resources.

*Figure 3-12*

- **Online Help**: Use the Online Manual option to access a PDF copy of the most recent version of the Media Editor manual.
- **View License Details**: Use the license details feature to see your currently licensed software features and modules, as well as enter a new license key.
- **About**: Use the about feature to see details about your currently installed version of Polycom RealPresence Media Editor.
Creating a Presentation

Creating a Presentation Overview

The presentation wizard is now ready to take you through four easy steps to create your presentation.

1. Select an interface for your presentation
2. Synchronize all the elements to be included in the presentation
3. Preview it to make sure it's the way you want it
4. Publish it to the web or locally

Selecting and Customizing an Interface

The Interfaces page is accessed by clicking on the "Skin" tab.

*Figure 4-1*

A SKIN is an interface, also referred to as a presentation window, that will contain all your media and production elements, and will be viewed by the end user.

The interfaces available for use are determined by the format of your streaming media file; a .wmv file will yield different interfaces than an .ismv file.
Figure 4-2

If you are using a customized skin, placing the finished skin in the selected skin folder (Set in Preferences) enables it to be displayed in the skins library.

Double-clicking on any skin in the Skins Library will give you a full-screen view of the skin to see more details.

Figure 4-3

Polycom RealPresence Media Editor interfaces now support the display of bookmarks as thumbnail icons of PowerPoint slides and images.
To select an interface, **highlight** the desired skin. After the skin is selected, a visual representation of the selected skin is displayed below the video window. This will remain throughout the publishing process in order to provide a visual guide of the final presentation.

*Figure 4-4*

Highlighting an interface in the skins library will also display a description of the skin. Each skin’s unique features are described in the skin description field.

*Figure 4-5*

After selecting an interface, you have the option of customizing the skin. To customize an interface, click **Customize Skin**.

*Figure 4-6*
The fields on this screen are dynamically determined by the skin you have selected. Some of the options that interfaces provide include: text fields for titles and subtitles, logo insertion with hot link, and email the presenter information.

Fill in each field to define the features and options that your skin contains. You have the option of leaving any or all of these fields blank.

**Example Custom Skin Fields**

- **Slide Titles Disabled**: Check this box if you’d like Media Editor to NOT automatically use the slide titles for the bookmark names.
- **Enable navigation**: Check this box if you would like the viewer to be able to navigate forward and back through any assets and URLs that have been synchronized.

After selecting and customizing an interface, click the **Sync** tab.

### Synchronizing Content

The Sync page is accessed by clicking on the Sync tab.

### Importing and Organizing Assets

On the Sync screen, the **Assets page** should be displayed. This is the page where assets will be imported into Media Editor and synchronized with the streaming content.

**ASSETS** consist of images (.jpgs and .gifs), .PPT slides, .PDF files and Flash files.

### Importing Assets

To import an asset for use in a presentation, click on the asset type icon.
Browse to the appropriate assets on your hard drive or disk. Select the assets and click OPEN.

The selected assets will be displayed in the Asset Library. There are two different ways to view assets in the assets library:

- thumbnail view

- zoom view
Click on the icon to switch between modes.

When in Full Screen Mode, you can navigate through your assets by clicking on the Next and Previous buttons.

Checking the Add image while navigating box will allow you to dynamically sync your assets while you navigate through them one by one by clicking the Next button.

**Arranging Assets**

To change the order of the assets, drag and drop the selected asset to where you want it to go (it will go in front of the asset you place it on).

To delete the Assets, click the button Clear all Items.

**Asset Titles**: This option enables you to give unique titles to some or all of the assets in your presentation.

These will be displayed in the skin if the check box for "Display Asset Titles" was checked.
**Auto Generate Bookmarks**: Use this option to automatically create a BOOKMARK or index point with each asset to be synchronized. A BOOKMARK defines a specific point within the presentation. Clicking on a bookmark enables a viewer to jump to discreet sections of the presentation that you have defined. Bookmarks will be displayed to the viewer within the skin.

This option will be grayed out if the skin does not support bookmarks.

*Figure 4-16*

**Synchronizing Assets**

After assets have been imported, click on the SYNC ASSETS button to synchronize a particular asset into your presentation.

**Real Time Synchronization on the fly**: Play the video stream by clicking the play button on the video control panel.

*Figure 4-17*

The run time of the video can be seen in two places:

- in the video control panel

*Figure 4-18*

- and on the TIMELINE.

*Figure 4-19*

The TIMELINE graphically displays the assets, URLs, and bookmarks that are synchronized within a presentation. They are displayed in linear sequence.
Select the first asset within the Asset Library to be synchronized.

When the video reaches the point when you want your asset to be displayed, click the SYNC ASSETS button.

An ASSET TAG is now displayed within the timeline at the exact point in time at which you synchronized it.

ASSET TAGS are color-coded hash marks that are displayed on the timeline after synchronization. See the Asset tags key located on the top right section of the timeline to determine which color signifies which asset.

After an asset is on the timeline, you can double-click it to see a preview of the asset. You can also double-click it in the assets list to preview the image.

**Synchronizing Assets Manually**: If you know the exact times that your assets will be synchronized, you can enter the time in the timer (See Figure 4-19, above), select the appropriate asset within the asset library and click the SYNC ASSETS button. Continue to do this until all assets have been synchronized. Synchronization of assets (and URLs and bookmarks) can be "undone" using the Undo feature. To undo a synchronization action, click Undo in the Edit drop-down menu.
Synchronizing URLs

To synchronize URLs, first click on the URLs tab within the SYNC page.

*Figure 4-24*

To add URLs into your presentation, first enter the web address into the URL field.

*Figure 4-25*

To preview the URL, click on the "Preview URL" button.

*Figure 4-26*

You can give each unique URL a title by entering text into the "URL Title" field.

*Figure 4-27*

**URL Lists:** URL lists enable a producer to enter all the URLs for the presentation prior to synchronization.

*Figure 4-28*
Add a URL to the list by clicking on the "Add URL to List" button.

*Figure 4-29*

Save the list by clicking the "Save List" button.

*Figure 4-30*

Open a previously created list by clicking on the "Open List" button and searching for your specific list.

*Figure 4-31*

Delete a URL from the list by clicking on the "Delete URL from List" button.

*Figure 4-32*

Highlight the URL either in the URL List or in the URL field if you are not using the list. Synchronize the URL into the presentation by clicking on the "SYNC URL" button.

*Figure 4-33*

You can Sync either in real time while your video is playing, or manually by entering a time in the timer.

URLs will be displayed on the timeline in yellow. After a URL is on the timeline, you can double-click it to see a preview of the URL.

**Creating and Synchronizing Bookmarks**

To begin creating and synchronizing bookmarks, first click on the Bookmarks tab within the SYNC page.
To add a bookmark, enter a bookmark title in the title field.

Synchronize the bookmark into the presentation by clicking on the "SYNC BOOKMARK" button.

Locking a bookmark to an asset: It is possible to lock a bookmark to a specific asset. When locked, the asset can be moved along the timeline and the bookmark point will move with it.

To lock a bookmark with an asset, right click on the asset tag and choose the "Lock" option.

The asset tag and the bookmark tag both become black, indicating that they are locked to one another.

To unlock a bookmark with an asset, right click on the asset tag and select "Unlock."
Bookmark List: To see a complete list of bookmarks, regardless of what page you are on within the presentation wizard, right click on any bookmark and select the "List" option up. This will display bookmark titles and times. Select a particular bookmark and the timeline will jump to the selected bookmark.

**Synchronizing Closed Captioning Text**

There are two ways to create Closed Captioning Text:

- typing in the text manually directly from Media Editor.
- importing an already existing closed captioning file.
After you double click on the Import Caption File a browse box will open up so you can browse for your desired file.

If you choose to import a closed captioning file, these are the accepted types.

- .smi or .sami (Microsoft CC file)
- .SAMI or .SMI

```xml
<SAMI>
<Head>
<Title>©accordent©</Title>
<STYLE TYPE='text/css'>
<!P {
```
The text file can be in plain English with a typical paragraph format, just like this example. When you import the text file, you can click on the drop down box to select how many characters you want displayed on each line (See Figure 4-45). Using the plain text format is beneficial when you have to manually type out what is being said outside of Media editor.

**Figure 4-42**

After importing the respective files or typing it manually from within Media Editor, the text will appear in the region above the Import Caption File. The timings will already be populated according to the timings in the closed captioning file. If you want to change the timings at all, or if you import a .txt file, synchronize the line at the time you wish it to appear at.
Creating a Presentation

Figure 4-43

You can double-click on any line of text to make any edits.

If you wish to delete an individual line or all of the lines, you can click on the Delete or Delete All Captions, respectively, as well as resort the captions by their time stamp.

Figure 4-44

Editing an Asset, URL or Bookmark

There are four ways to make changes to your synchronized events:

- Drag-and-drop editing
- Using the right-click editing functions
- Using the My Assets drop-down menu
- Using the scrollbar

Drag-and-drop editing

Click on the asset you wish to change and drag it to the place on the timeline where you would like it to go. If you hold down the left mouse button and drag the cursor over multiple assets, it will highlight those selected assets, allowing you to move more than one asset at a time.

The time in the timer will change as you drag along the timeline, indicating the runtime of the presentation.
Using The Right-Click Functions To Edit

By right clicking on an asset, URL, or bookmark marker, a series of editing options will appear.

- Delete
- List
- Shift
- Edit

Figure 4-45

With the exception of the "Edit" feature, all of these options work identically for assets, URLs and bookmarks.

Delete: The delete feature enables you to delete a specific marker, all of the markers in a particular region, or all markers on the timeline.

List: If you choose the "list" option, a list of assets will appear for your entire presentation.

Figure 4-46

The asset tag is displayed on the appropriate line within the timeline, depending on which region was targeted.
Shift: The shift option enables you to move an event or several events forward or backward by a specific amount of time (See Figure 4-50). This is very useful when the streaming file is edited at the beginning (for example, an introduction is affixed to the beginning of the file), resulting in all of the synchronized content having to be shifted by the amount of time of the added or deleted content.

Figure 4-47

Edit Assets Only: If you choose the "edit" option, the "Edit Image Details" pop up will appear. In this mode you can change the title, the event time, the target region, or the image path (if applicable). It also enables you to preview the asset by selecting the "Preview" button.

Figure 4-48

Clicking on the "Preview" button will enable you to see an image of the asset.
Edit URLs Only: Right click on the URL you wish to change and choose the edit option. The "Edit URL Details" pop up will appear. In this mode, you can change the title, the event time and the target region.

*Figure 4-49*

Edit Bookmarks Only: Right click on the bookmark you wish to change and choose the edit option. The "Edit Bookmark Details" pop up will appear. In this mode you can change the title and the event time.

*Figure 4-50*

**Editing Using My Assets**

On the Assets drop-down menu, choose "My Assets."

*Figure 4-51*
The current list of assets and URLs for your presentation will be displayed. Bookmarks are not visible on this list; bookmarks are displayed within their own list.

**Figure 4-52**

![Image of Polycom RealPresence Media Editor](image)

Double-click on any of the fields to see a preview of the asset or URL. The bottom portion of the assets list has fields for changing the time of the event as well as the region to which the event is targeted. After making a change, click Update.

**Editing Using The Scrollbar**

The SCROLLBAR is the bar that moves (scrolls) along the timeline as the media file plays.

**Figure 4-53**

![Image of scrollbar](image)

Mouse over the scrollbar and click and drag it to move to the desired location within the media stream. You will see the runtime of the video displayed in the timer.
The media stream must either be paused or playing in order to manually drag the scrollbar.

**Editing Using the Thumbnail Editor**

This feature can be found on the menu bar under Assets. This enables you to see the assets you have synchronized, the timings of those assets, any associated bookmarks and enables you to update any of the information tied to any given asset.

*Figure 4-54*

You can change the number of Thumbnails shown in the window by selecting the button which shows the number of thumbnails you want displayed per page.

*Figure 4-55*

**Edit Images**

The Edit Images section gives you the name of the asset you have clicked on as well as the timing. You can either update the time or delete the image altogether.
**Edit Bookmarks**

The Edit Bookmarks section enables you to change the name of the bookmark selected, delete the selected bookmark or delete all of the bookmarks in the presentation.

**Selection**

The Selection section shows you the number of assets you have selected from the list.

There are multiple methods to select assets from the thumbnail list:

- First, to select an individual thumbnail, simply click on that thumbnail.
- To select multiple thumbnails, hold down the CTRL button and select the thumbnails you want highlighted. Alternatively, you can hold down the Shift key, click the first and last thumbnail - which will highlight all of the thumbnails between the two thumbnails you have selected.
- Finally, you can click on All radio button below the thumbnail screen and click the highlight button in order to highlight all of your assets. You can also click the None radio button to deselect all of your assets.
Using the Mark In/Mark Out Feature to Edit The Presentation

Before a presentation is posted on demand, the presenter may want to delete a portion of the content at the beginning or end of the presentation. e.g. the speaker was not yet ready, the first few minutes were used to test the encoder, etc.

The Mark In and Mark Out features enable a presenter to edit the presentation (cut off the unwanted content at the beginning and end of a presentation) by marking points in the presentation that will become the new start and end time for the presentation. The Mark In feature is used to delete content at the beginning of a presentation; the Mark Out feature is used to delete content at the end of a presentation.

To edit the length of a presentation, first select Edit Video Length in the Edit drop-down menu.

*Figure 4-60*

Immediately after selecting Edit Video Length, the Mark In/Out window will appear.

*Figure 4-61*

To Mark In a presentation, first select Mark In.
Creating a Presentation

Figure 4-62

As soon as Mark In is selected, the Mark In time field will become active. Enter the amount of time that should be edited from the beginning of the media file in the Mark In time field.

Figure 4-63

Beneath the "Mark In" fields are the "Mark Out" fields. Use these fields in the same way to remove content from the end of a media file. Then click Apply.

Figure 4-64

Using the Import/Export Timing Files Feature

Polycom RealPresence Media Editor enables a content author to export and import synchronization timing files as .csv files. The benefit of this feature is that it enables synchronization files to be transferred among multiple content creators (without transferring an entire presentation) and it also enables the synchronized content to be compiled even if the streaming file is not yet completed.

To export (or import) synchronization files, click Export (or Import) in the Assets drop-down menu (See Figure 4-68). The Export option enables you to export your asset lists for either Media Editor or Polycom RealPresence Broadcast Producer (if you are using Broadcast Producer as well).
Immediately after clicking Export, the Export Assets window will appear.

In the Export Assets window, browse for the location where you want to save the synchronization timing files and click Save.

The saved file will be a .csv file (Excel file). It is important to note that the file will contain the following fields: Type, Time, Path/URL, Target and Title.

- **Type field**: The Type field dictates what type of asset is being synchronized.
- **Time field**: Denotes in seconds when the asset is being synchronized.
- **Path/URL field**: Specifies the location of the synchronized asset.
- **Target field**: Specifies the target region where the synchronized content is displayed.
- **Title field**: Specifies the title of the synchronized content.

The Export feature will automatically organize the synchronized timing files in the above format. These files, however, can be created in Excel directly without
Creating a Presentation

- Media Editor and imported into Media Editor using the Import Assets feature.

To import assets, click Import CSV in the assets drop-down menu. Then locate the .csv file with the synchronization timing files that you want to import.

**Figure 4-67**

After the desired file is selected, click Open. To import an asset file that was generated through a PowerPoint Plugin, follow the same procedure except select the Import PowerPoint AddIn option instead of the CSV option.

**Using the Break In Break Out Feature**

The Break In Break Out feature enables users to add cue points in the timeline to chop out unwanted sections of the presentations, including Video, Events, Bookmarks and Closed Captions. By using this feature, large presentations can be reduced significantly in size for easier delivery.

After a video is loaded, the user will see a "GREEN" line, right above the timeline displaying the total length of the video.

**Figure 4-68**

A Break In Break Out point can be added in two ways:

- Menu Edit > Add Break In Break Out
• Shortcut key F12

**Figure 4-69**

A Break In Break Out point gets added just like any other event based on the value in time text field.

After a cue point is added, user will see a "YELLOW" line getting added from the point to the end of the "GREEN" line. This tells the user that a "Break In" point has been added and that they need to insert a "Break Out" point.

**Figure 4-70**

When the user clicks F12 or the menu command, they will see a "RED" line getting added from the "Break IN" Point to the "Break Out" point, displaying the part that is ready to be chopped out during the Publishing process.

**Figure 4-71**

A user can add as many Break In Break Out points, within the length of the Green Line that is the length of the video, based on their requirements.

A user must complete a Break In point with a Break Out point - otherwise a message warning will be presented during "Saving" and "Publishing" the presentation and it will not proceed further.
Editing Break In Break Out points

There are three ways to edit the added Break In Break Out points:

- Right-click on the "RED" line, which shows a popup menu.

**Figure 4-72**

Remove removes the Red Line and that specific Cue point.

Edit pops up a modal window "Edit Break In Break Out Details", which specifies the In and Out points which the user can edit based on what they need.

**Figure 4-73**

- Drag the mouse on the "RED" line and it will change to a different cursor. After the cursor changes, the user can drag the red line, just like any other event, to a different position, automatically updating the In and Out points.

- Click Edit > Break In Break Out Settings.

**Figure 4-74**
This option presents a modal Dialog with the Break In / Break Out List containing all the cue points added. The section that is not needed is displayed in Red; the section(s) that are needed are displayed in Green (as per the timeline colors). A user can double click in any cell and change the time, automatically reflecting the change in the overlapping cue points and changing the cue points in the timeline.

Figure 4-75

A user can also "ADD" or "DELETE" the previously added Cue points. Clicking "ADD" will create new Green and Red rows in the grid; clicking "DELETE" can only delete the "RED" rows and not the "GREEN" rows since the main timeline cannot be deleted.

Output of Break In Break Out

When the user publishes the presentation, the output is generated based on Break In Break Out points. The Video, Events, Bookmarks and Closed Captions are automatically Shifted / Deleted, based on the information on the timeline.

Limitations of the Break In Break Out feature

The Break In Break Out feature is only available for .WMV and .RM media types. The user will see the "Green" line above the timeline displaying the length of the video for available media types.

Break In Break Out cue points cannot be added closer together than one second.

Break In Break Out cannot be used as Mark In Mark Out as it reverses the purpose of using it.
Working with Polycom RealPresence Capture Station Break In Break Out Content

A presentation loaded from a Capture Station will automatically insert the Break In Break Out points in the timeline. Users can follow the same process described above to Edit the cue points.

AutoSave Options

Media Editor has an autosave feature that enables the user to recover data in the event of the program crashing unexpectedly. By default the Autosave feature saves the presentation after every 5 minutes.

A user can change the Autosave option by going to Edit>Preferences or by pressing the F5 shortcut key.

Figure 4-76

A new window will appear. Under Autosave Options, a user can Enable/Disable the Autosave feature and set the time interval for saving the file.

Figure 4-77
After every [autosave minutes] specified, Media Editor creates a file named untitled_tmp.prp in the project directory.

Note: if the file was saved prior to auto save, it will have the name as [filename_tmp.prp].

The next time a user tries to load the project, it will give them an option to load the autosaved file.
Previewing a Presentation

Choosing Preview Modes

To begin the preview process, first click on the Preview tab.

Figure 5-1

Figure 5-2
Previewing A Presentation

After you have selected your preview mode, play your streaming media file by clicking the play button on the video control panel.

The assets and URLs that you synchronized in your presentation will be displayed in their predetermined sequence.

*Figure 5-3*

If you need to make a change, either right click on the particular asset or URL on the timeline, and choose the "edit" option or go back to the SYNC page to edit your changes.

Previewing Bookmarks: Each bookmark title and time is displayed in the preview pane.
Bookmarks will be displayed in their sequential order. If the first bookmark is at :10, the bookmark title and time will display at :10 and remain displayed until the next bookmark.
Archiving and Publishing a Presentation

Archiving and Publishing Overview

After synchronizing and previewing a presentation, you can use Polycom RealPresence Media Editor to publish a presentation locally (local drive, network drive, or CD) and to the Web.

To start the publishing process, click the Publish tab.

*Figure 6-1*

Immediately after clicking the Publish tab, the Publish page will appear.

*Figure 6-2*
On the Publish page, enter a project (or presentation) name in the Project Folder field. This is the name that will be used to locate the folder containing the presentation and all of the presentation assets.

*Figure 6-3*

You can also select the option to use the original video name as your project name by selecting the check box.

For Polycom RealPresence Capture Station Presentations being inserted into a Polycom RealPresence Media Manager Portal, the use new presentation ID checkbox is also enabled. If you are publishing with the intent of re-scanning an already scanned presentation in Media Manager, and will be publishing to a new folder, you should check this box to enable generation of a new GUID (Globally Unique Identifier) for that presentation.

*Figure 6-4*

Do not use spaces in the project name. Many browsers have difficulties using spaces in a URL.

After naming the project folder, use the Publishing Options fields to specify whether the presentation will be published locally or to the Web.

*Figure 6-5*

- Choosing “Publish Locally” will publish the presentation and all presentation assets to a local drive.
- Choosing “Publish to the Web” will transfer the streaming assets to a streaming server and the web content, such as slides and graphics, to a web server.

To publish locally, select Publish Locally, and then proceed to “Completing The Publish Screen” on page 6-13.

To publish to the Web, select Publish to Web. Immediately after selecting Publish to Web, the “Change Publish Settings” button will become active.
The Change Publish Settings screen is used to prescribe the settings that will be used to publish the presentation to the Web. To initiate this process, click Change Publish Settings.

Immediately after clicking Change Publish Settings, the Settings screen will appear with the Web Content window displayed.

**Settings Screen Overview**

Unless a presentation is being published to a local drive or CD, it is necessary to specify the settings that will be used to publish the presentation to the Web.

The Settings screen is used to preset the information that will be used to publish a presentation from a workstation to streaming and web servers.
It is necessary to have access to a web server and streaming server to publish on demand streaming presentations to the Web. However, if a presentation is being published to a local drive or to CD only, none of the above mentioned accounts is required (See “Completing the Web Content Page” on page 6-4).

Completing the Web Content Page

The Web Content page is used to input the following publishing information:

- The Web Server URL, which is the URL that the audience will use to launch the presentation.
- The Upload Type, which designates whether FTP/SFTP or UNC will be used to upload the presentation to the web server.
- The FTP/SFTP or UNC Upload Settings, which are the specific settings and passwords that are needed to upload the presentation to servers via either an FTP/SFTP server or UNC path.

If the Web Content page is not displayed, click the Web Content tab on the Settings Information screen.

Web Server URL Field

In the Web Server URL field, enter the URL that the audience will click to view the interface graphics.

Figure 6-9
**Upload Type Field**

The Upload Type field is used to designate whether the presentation will be uploaded to a web server using an FTP/SFTP server or Universal Naming Convention (“UNC”).

An FTP/SFTP server is the more common upload method, particularly if the web server is offsite and/or managed by a third-party. Using a UNC path is typically used only when the web server is onsite and managed internally.

To use an FTP/SFTP upload server, select FTP or SFTP. To use a UNC path, select UC.

*Figure 6-10*

If UNC was selected, proceed to “Completing the UNC Fields” on page 6-10. If FTP/SFTP was selected, the FTP/SFTP Upload Setting menu will appear containing four FTP/SFTP related fields.

*Figure 6-11*

**Completing the FTP/SFTP Upload Setting Fields**

If FTP/SFTP is the selected upload type, complete the FTP/SFTP Server, User Name, Password, Directory and Port fields as follows.

- **FTP/SFTP Server Field**
  In the FTP/SFTP Server field, enter the IP address for the FTP/SFTP Server that will be used to publish the presentation.

- **User Name Field**
  In the User Name field, enter the User ID for the FTP/SFTP Server.

- **Password Field**
  In the Password field, enter the password for the FTP/SFTP Server.

- **Directory Field**
  The Directory field gives the presenter the option of putting a presentation in a preexisting FTP/SFTP directory. To put a presentation in an FTP/SFTP directory, enter the directory in the Directory field.
After the FTP/SFTP Upload Type fields have been completed, the user has the option of testing the FTP/SFTP settings. To test the FTP/SFTP settings, click Test FTP/SFTP Connection.

*Figure 6-12*

If the FTP/SFTP settings have been correctly entered, an “OK” message will appear.

*Figure 6-13*

If the FTP/SFTP settings have been incorrectly entered, an Error message will appear.

*Figure 6-14*

After checking FTP/SFTP settings, click the Smooth Streaming, Windows Media or Flash Media tab depending on the format of the streaming content you are using.
Proceed to “Completing the Smooth Streaming Media, Windows Media and Flash Media Content Pages” on page 6-8.

Completing the UC Fields

If UNC is the selected upload type, it is necessary to complete the Upload Path.

To create a UNC upload path, enter the UNC path in the Upload Path field.

UNC names consist of three parts: a server name, a share name, and an optional file path. The three parts are combined using backslashes as follows: `\\server\share\file_path`

After a UNC path has been entered, click on the Smooth Streaming Media, Windows Media, or Flash Media Content tab.
Completing the Smooth Streaming Media, Windows Media and Flash Media Content Pages

The Smooth Streaming Media, Windows Media and Flash Media content pages are used to prescribe where the on demand video/audio content will be published and how the on demand video content will be published to the audience. These pages contain identical fields and the following instructions should be used for both formats.

The components of the Smooth Streaming Media, Windows Media and Flash Media content pages are as follows:

- The URL link field will contain the link that a viewer would access to view the on demand video only.
- The FTP/SFTP or UNC Upload Settings, which are the specific settings and passwords that are needed to upload the presentation to the streaming servers via either an FTP/SFTP server or UNC path.

To complete this information, first make certain that the appropriate format page is displayed. If the correct format page is not displayed, click the Smooth Streaming Media, Windows Media or Flash Media tab.

Figure 6-18

Completing the Video On Demand (VOD) Screen

After the appropriate VOD Content page is displayed, the fields on the VOD Content page should be completed as follows.

- Video On Demand URL Field: In the URL field, enter the link that a viewer would click to watch the on demand video that is being incorporated into the presentation.
- Upload Type Field: The Upload Type field is used to designate whether the presentation will be uploaded to a web server using an FTP/SFTP server or a UNC path.

To use an FTP/SFTP upload server, select FTP/SFTP. Otherwise proceed to “Completing the UNC Fields” on page 6-10.

If FTP/SFTP was selected, the FTP/SFTP Upload Setting menu will appear containing four FTP/SFTP-related fields.
Completing the FTP/SFTP Upload Setting Fields

If UNC is the selected upload type, proceed to “Completing the UNC Fields” on page 6-10.

If FTP/SFTP is the selected upload type, complete the FTP/SFTP Server, User Name, Password, Directory, and Port fields as follows.

- FTP/SFTP Server Field: In the FTP/SFTP Server field, enter the IP address for the FTP/SFTP Server that will be used to publish the presentation.
- User Name Field: In the User Name field, enter the User ID for the FTP/SFTP Server.
- Password Field: In the Password field, enter the password for the FTP/SFTP Server.
- Directory Field: The Directory field gives the presenter the option of putting a presentation in a preexisting FTP/SFTP directory. To put a presentation in an FTP/SFTP directory, enter the directory in the Directory field.

After the FTP/SFTP Upload Type fields have been completed, the user has the option of testing the FTP/SFTP settings. To test the FTP/SFTP settings, click Test FTP/SFTP Connection.

If the FTP/SFTP settings have been correctly entered, an OK message will appear.

If the FTP/SFTP settings have been incorrectly entered, an Error message will appear.
After the FTP/SFTP Upload Type fields have been completed, click the Firewall Settings tab.

Immediately after clicking the Firewall Settings tab, the Firewall Settings page will appear.

Proceed to “Firewall Settings Page” on page 6-11.

**Completing the UNC Fields**

If UNC is the selected upload type, it is necessary to complete the Upload Path. To create a UNC upload path, enter the UNC path in the Upload Path field.
After a UNC path has been entered, click on the Firewall Settings tab. Immediately after clicking the Firewall Settings tab, the Firewall page will appear.

**Firewall Settings Page**

In addition to the standard FTP/SFTP settings, Media Editor includes advanced settings that can be used to publish to an active FTP/SFTP server and to a proxy server to FTP/SFTP through a firewall.

On the Smooth Streaming Media, Windows Media and Flash Media pages, it is first necessary to specify whether an active or passive FTP/SFTP is being used. To specify an FTP/SFTP connection type, select Passive or Active.
After an FTP/SFTP connection has been selected, the Firewall Support fields can be used to designate a proxy server that will be used to FTP/SFTP through the firewall.

**Figure 6-28**

- **Off/On Fields:** The On and Off fields are used to enable and disable firewall support. If firewall support is required, select On.
- **Firewall Type Fields:** The Firewall Type field is used to select the type of firewall being used. To select a firewall type, use the Firewall Type drop-down menu and highlight the desired firewall type.
- **Firewall Host Field:** The Firewall Host field is used to specify the IP address for the firewall.
- **Firewall Port Field:** The Firewall Port field is used to specify the port address for the firewall.
- **Firewall Logon Name Field:** The Firewall Logon Name field is used to input the user logon. Depending on the configuration and firewall being used, it may not be necessary to complete this field.
- **Firewall Password Field:** The Firewall Password field is used to input the user password. Depending on the configuration and firewall being used, it may not be necessary to complete this field.

After completing the Firewall Settings fields, click Save.
Immediately after clicking Save, you will be returned to the Accordent PresenterPLUS Publish screen.

**Completing The Publish Screen**

If you have completed the Settings screen or chosen Local media, the next step is to specify whether the synchronized content will be resized to fit the frames within the audience interface.

This step can be skipped if no synchronized assets, such as images and PDFs, have been included in the presentation (for example, only URLs have been synchronized with the presentation).

Polycom RealPresence Media Editor enables you to decide whether the content targeted to a particular frame is resized and which frames will resize the content.

To resize synchronized content, select Resize Region.
The next step is to specify whether images will be converted to jpeg or gif format. To specify the format, select jpeg or gif.

Media Editor includes proprietary gif conversion functionality that creates gif files that are 50% smaller and 75% clearer than files created using traditional conversion techniques.

If you select jpeg, you can use the Image Compression Quality feature to specify the compression quality that will be used. The primary considerations are image quality and the resulting image file size. It is recommended that if the images are an important component of the presentation, that you use a compression quality higher than 70%.

The Compression Quality feature default is 80%.

Prior to publishing, you can determine whether you would like to publish to Blackboard (if you have the appropriate license and select the Publish to Blackboard checkbox) and whether or not you would like to add additional packaging options. The ZIP option will zip up all of the local project files for your presentation so you can send it to a viewer in a compressed and packaged format. The EXE option is very much like the ZIP in the sense that it is self-extracting; the difference is that the EXE option will enable your viewer to double click the EXE file to automatically launch the presentation. Both the ZIP and EXE options can be password protected if desired. To publish the presentation, click Publish Presentation.
Immediately after clicking Publish Presentation, Accordent PresenterPLUS will begin generating the presentation.

After Media Editor has generated the presentation, you can do the following:

- Close Media Editor.
- Preview the presentation.
- Save the presentation and apply the same synchronization files to a different media file.
- Write the presentation directly to a writeable disc (requires a CD/DVD burner and blank disc).
- Open the presentation folder.

To preview the presentation, click Launch Presentation.
To apply the same synchronization files to a different media file, click Change Media Type.
To burn your presentation directly to a CD, click Write to CD. The Write to Disc page will open.

The Volume ID enables you to specify the name of the disc you are about to create. Next select your CD-burning drive.

At the bottom left of the Write to Disc page, you will see the number of files that will be written to your CD as well as the total size. After you have verified that your writable disc is large enough to hold the presentation and you have selected all of your desired options, click Write to Disc.
Using Resources and Shortcuts

Drop-Down Menu Overview

The Media Editor drop-down menus provide access to several helpful features, shortcuts, content resources and support resources. Below is an overview of the Media Editor drop-down menus.

File Menu

The File drop-down menu contains several function and feature shortcuts, including New Presentation, Save Presentation, Load Presentation, Change Media Type and Exit.

Figure 7-1

- New Presentation: The New Presentation option enables you to start a new presentation by linking directly to the Choose Presentation Type screen at any time. If you are working on a presentation, you will have the option of saving the current presentation before commencing a new one.
- Save Presentation: The Save Presentation feature enables you to save a presentation at any time, as well as to name a project folder and determine where the folder will be located.
- Save Presentation As: The Save Presentation feature enables you to save a presentation using a different folder name and determine where the folder will be located.
- Load Presentation: The Load Presentation feature enables you to import a previously created presentation. After import, you will be able to edit and republish the presentation, if desired.
• Change Media Type: The Change Media Type feature is used to import a new media file without losing any of the synchronization work that has been done. This is a great way of publishing the same presentation in multiple formats without having to repeat any work.

• Exit: After providing an opportunity to save the presentation, the Exit feature will close Media Editor.

**Edit Menu**

The Edit drop-down menu contains the Server Settings and Preferences options.

*Figure 7-2*

• Undo: The Undo option is used to undo the last synchronization action, for example, synchronizing a PowerPoint slide.

• Redo: The Redo option is used to reverse an Undo action.

• Edit Video Length: The Edit Video Length option is used to edit the beginning and end of a piece of video content, also referred to as cropping and Mark in/Mark out.

• Server Settings: The Server Settings option is used to set the web and streaming server information for publishing to the Web. This screen can also be accessed by clicking the “Change Publish Settings” button on the Publish Page.

• Blackboard Settings: The Blackboard Settings option is used to launch the Blackboard Settings which include the Blackboard server you will be accessing as well as log in information to access the Blackboard server. Please note that this option will only be available if you have purchased the Blackboard Integration from Polycom.

• Preferences: The Preferences option is used to customize the region names that show on the time bar. By customizing the region names, it is easier to determine which synchronized content should be sent to which region.

• Kontiki Settings: The Kontiki Settings option is used to access the Kontiki Settings page. Please note that this option will be available only if you have purchased the Kontiki integration from Polycom. The Kontiki Settings page is described later in this chapter.
Assets Menu

The Assets Menu contains the My Assets options.

Figure 7-3

- My Assets: The My Assets option is used to launch the Current Assets Lists screen. This screen can be used to view which assets have been synchronized and their respective synchronization times, as well as to edit synchronized content.

- Export: The Export option is used to export the synchronization timing files and associated media locations to a .csv file that can be saved to a local file or transferred to a third party. These assets can either be exported in the Media Editor format or as a Polycom RealPresence Broadcast Producer file.

- Import PowerPoint Addin and Import CSV: The Import option, for both methods, are used to import a .txt file which contains synchronization timings generated from the Polycom Powerpoint AddIn or a .csv file which contains synchronization timing files and associated media locations, respectively.

- Thumbnail Editor: The Thumbnail Editor option enables you to launch the Thumbnail Editor window to make changes to your asset and bookmark timings and names, as well as delete them. This option can also be accessed through the Thumbnail Editor button located directly above the timeline.

- Delete Selected: The Delete Selected option is used to remove markers from the timeline which are selected. This option will only appear if you have asset markers selected.

- Clear Images: The Clear Images option is used to clear all images from the timeline. This feature is not used to clear images from the asset library.

- Clear URLs: The Clear URLs option is used to clear all URLs from the timeline.

- Clear Bookmarks: The Clear Bookmarks option is used to clear all bookmarks from the timeline.
Help Menu

The Help Menu contains links to important support and product information, as well as access to additional resources, including downloadable interfaces.

Figure 7-4

- Online Manual: Use the Online Manual option to access a PDF copy of the most recent version of the Media Editor Manual.
- About: Use the Online Help feature to learn about the version of Media Editor that you are currently running.
- View License Details: Use the view license details feature to view your currently licensed features, or enter a new license key.

Kontiki Settings

After you have selected the Kontiki Settings page, a new window will appear.

Figure 7-5

The Kontiki Publisher URL is for entering the URL which is used to access your Kontiki server access point. The User Name and Password are for authenticating to your Kontiki server. The Small and Medium Image Icon are used to browse to the image you would like to associate with your presentation after it is on the Kontiki server.
Media Editor Hot Keys

As you become more familiar with the Media Editor workflow, you may want to use some of the shortcuts (or “hot keys”) that have been included to expedite navigation around Media Editor. The following table describes the primary shortcut keys.

<table>
<thead>
<tr>
<th>Shortcut Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Access the Online Manual</td>
</tr>
<tr>
<td>F2</td>
<td>Switch the media you are using for the presentation</td>
</tr>
<tr>
<td>F3</td>
<td>Open the window that enables you to edit the video length</td>
</tr>
<tr>
<td>F4</td>
<td>Open the Thumbnail Editor where you can edit your assets and bookmarks</td>
</tr>
<tr>
<td>F5</td>
<td>Launch the Preferences window which will enable you to change the names of the regions in the timeline</td>
</tr>
<tr>
<td>F6</td>
<td>Clear your Images</td>
</tr>
<tr>
<td>F7</td>
<td>Clear your URLs</td>
</tr>
<tr>
<td>F8</td>
<td>Clear your Bookmarks</td>
</tr>
<tr>
<td>F9</td>
<td>Access Online Help</td>
</tr>
<tr>
<td>Ctrl + F2</td>
<td>Access the Settings screen where you input the web and streaming server information that will be used to publish a presentation to the Web</td>
</tr>
<tr>
<td>Ctrl + A</td>
<td>“Save Presentation As” file window</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td>Start a new presentation</td>
</tr>
<tr>
<td></td>
<td>This shortcut enables you to jump to the Choose Presentation Type screen at any time. If you are working on a presentation, you will have the option of saving the current presentation before commencing a new one.</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save a presentation at any time, as well as to name a project folder and determine where the folder will be located</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Jump to two different screens, depending on what screen you are using in Media Editor</td>
</tr>
<tr>
<td></td>
<td>If you are on the Choose Presentation Type screen, you can use this shortcut to jump to a Browse window which, after selecting a media file, will launch Media Editor.</td>
</tr>
<tr>
<td></td>
<td>If you are in the main Media Editor application, this shortcut enables you to import a previously created presentation. After imported, you will be able to edit and republish the presentation, if desired.</td>
</tr>
<tr>
<td>Ctrl + Z</td>
<td>Undo your last edit</td>
</tr>
<tr>
<td>Shortcut Key</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Ctrl + R</td>
<td>Redo your last undo</td>
</tr>
<tr>
<td>Ctrl + B</td>
<td>Access your Blackboard settings that will enable you to configure Media Editor to use your Blackboard server</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td>Import aa Polycom PowerPoint Addin created asset list</td>
</tr>
<tr>
<td>Del</td>
<td>Delete the asset markers you have selected</td>
</tr>
</tbody>
</table>